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SOFTWARE/EQUIPMENT NEEDED: 

Corel Painter IX.5 –   www.corel.com  

 Corel's Painter IX.5 is the closest software to reproduce the effects of 
paints and brushes with a digital palette.  It is a Natural-Media® painting and illustration software. It 
is primarily designed for artists who draw freehand. Mastering Painter still takes time, but Corel 
made a few smart tweaks. For instance, cloning, which lets you paint over a photograph, now takes 
one step instead of five.  You also need a pen tablet such as Wacom's Intuos 3 to fully explore its 
potential. If you're a serious artist, this ingenious package is a rewarding investment in your 
creativity.   Retail price: $369.00 

Minimum System Requirements  
Macintosh®:  

• Mac OS® X (version 10.2.8 or higher)  

• Power Macintosh® G3, 500 MHz or greater  

• 128MB of RAM (256MB recommended)  

• Mouse or tablet  

• 24-bit color display  

• 1,024x768 or greater monitor resolution  

• CD-ROM  

• 395MB of available hard disk space  

Windows®:  

• Windows 2000 or Windows XP (with latest service packs)  

• Pentium® II, 500 MHz or greater  

• 128 MB RAM (256MB recommended)  

• Mouse or tablet  

• 24-bit color display  

• 1024x768 or greater monitor resolution  

• CD-ROM  

• 380MB of available hard disk space  

Intuos Wacom Tablet – www.wacom.com  
 
Intuos3 6x8  

Tablet dimensions: 13.6" x 10.3" x .5" 

Active area: 6" x 8" 

Pressure levels: 1024 

Resolution: 5080 lpi 

Max. data rate: 200 pps 

Accuracy: +- .01" 

Tilt range: +-60º 
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Contents:  
•  Metallic gray Intuos3 6x8 Pen Tablet, Intuos3 Grip Pen, Five-button Mouse, and Pen Stand.  
•  CD with Wacom tablet driver software and user manual  
•  DVD with bundled software  
•  Two-year warranty  
 
System requirements: 
Intuos3 pen tablet requires a PC or Macintosh computer running Windows Vista, XP, or 2000, or Mac OS X 10.2.8+ 
with a powered USB port and a CD-ROM or DVD drive to install the driver software. 
 
A DVD drive is required to install the included software. 

 
Layout is very similar to Photoshop: 
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 Toolbox 
 File/Edit/Canvas/Layers/Select/Shapes/Effects/Movie/Window/Help 
 Brush Drop Down 
 
GETTING STARTED (to paint over photographs): 
 
One way to use the Corel Painter cloning feature is to clone an entire file, creating a clone source–destination 
relationship between two documents. The clone of the file is more than a copy. It maintains a pixel-for-pixel 
correspondence with its source document. For this reason, the source must remain open while you work in the clone. 
 
Open a file in Painter – MUST BE AN 8-BIT FILE.  This will be your source file.  You WILL NOT paint on this file. You are 
going to clone the source file. 
  
File>Clone 

   
(The newly cloned file will now be automatically named “Clone of ….” 
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If you save the “clone file” to come back to work on later, you must open up the “source” file 
again, AND select the source file under File>CloneSource, to get the same pixel-to-pixel-
relationship between the source document and the cloned file. 

 

 
 
 
READY TO PAINT – SELECT YOUR BRUSH CATEGORY and brush: 
 
 We are going to use a Square Chalk 35 
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CUSTOM PALETTE 

To give you the freedom to work in your own style, Corel Painter lets you create custom palettes that contain exactly the 
features you want. Because the features on a custom palette are immediately available, you can choose them with a single 
click. You can place items from the Brush Selector bar, any of the six content selectors (papers, patterns, looks, weaves, 
nozzles, or gradients), Library palettes, or Script palette on a custom palette. You can also add any menu command, such 
as File menu > New, to a custom palette. 

 

 
 First step: - Drag and drop 

Drag an icon or button out of its palette or out of the Brush Selector bar.  
Corel Painter creates a custom palette that contains an icon for the item you dragged . 
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Sizing/Rearranging 
To rearrange the layout in a custom palette  

•   Hold down the Shift key, and move the icon or button to where you want it. 
  To change the size of the custom palette, grab and the pull the lower right hand corner

To delete an item from a custom palette  
•   Hold down the Shift key, and drag the icon or button off the palette. 

 Naming 
Window>Custom Palette>Organizer>Rename 
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PAINTING with Square Chalk 35: 
START by increasing the size of the brush and decreasing the opacity 

 

 
 
Next:  Turn off the Color Palette/turn on the Cloner Color Button: 
 

Using Clone Color  
You can turn almost any brush into a cloner with the Clone Color button. The Clone Color button causes a brush to pick 
up color from the source image while staying true to its own stroke nature. The Clone Color button is useful for creating 
mosaics and tessellations based on a source image.  
 

 
 
To use Clone Color  
1   Choose Window > Color Palettes>Show Colors to display the Colors palette.  
 If the Colors palette is not expanded, click the palette arrow.
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2 Click the Clone Color button (the colors in the Color Wheel will look muted when you click on the button) 
Each time you start using a brush that you have not used before, you must turn off the color palette/turn on the clone color button ! 
 
Now, finally – we can start painting !!! 
 
Start with the background and work towards the foreground. When painting detail -  FOLLOW THE CONTOURS OF 
YOUR SUBJECT and use larger brush size/less opacity (you can also use the bracket keys – just like in PS to increase 
or decrease the size of the brush) for soft, blurry effects, such as in a background; and, use smaller brush size/more 
opacity for detail work. 
 
Do not mess with Grain, Resat, Bleed or Jitter in the beginning (default values are given when you select the brush).  
You need to develop skill in changing just two variables to start with - brush size and opacity - to learn how those 
changes impact your painting.  Stylus pressure also increases or decreases opacity, and learning how to lighten your 
touch or increase pressure on the drawing tablet takes some practice. 
 
Painter has multiple undo's, just like Photoshop. However, there is a difference. Command Z (or Control Z on a PC) is 
undo.  If you hit Command/Control Z four times Painter will undo the last four commands. If you want to re-do 
something, you must choose Command/Control Y. In other words, Control/Command Z does not toggle back and forth 
between undo and redo. It is ONLY undo. Redo is Command/Control Y.  
 
Size 
The Size brush feature determines how Corel Painter varies the width of the brush stroke. Besides using the Brush Size Slider on 
the Property Bar, brush size can also be increased or decreased by using the bracket keys on the keyboard, and also by 
programming your Wacom tablet (instructions for programming the keys on the tablet come with the installation CD) so that one 
of the scroll bars is used for increasing and decreasing brush size. 
 
Opacity  
The Opacity slider controls the degree to which a stroke “covers” or “builds up” on the underlying pixels.  
When Opacity setting is low, the applied color is thin, allowing you to see through to the underlying colors. When the setting is 
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high, the applied color covers underlying pixels more completely. 
Some methods and dab types do not allow for adjustments in opacity. 
 
When you are comfortable with changing brush size and opacity, then you can experiment with the other 
brush controls. 
 
BRUSH CONTROLS on the Property Bar: 
Grain  
The Grain slider controls how much color penetrates into the paper texture. Lower settings show more of the grain.  
To set grain  
On the Brush property bar, type a percentage in the Grain box, or adjust the pop-up slider. 
 Move the slider to the left to reduce penetration and reveal more texture. Move it to the right to increase penetration and reveal 

less grain 
For liquid media brushes, Grain controls the amount of “pull.” For Image Hose brushes, Grain controls the mixture with the 
additional color. For other brushes, such as airbrushes, the Grain slider is not available. 
 
Resat 
The Resaturation slider controls the amount of color that is replenished in a stroke. If it is set at zero, the brush does not produce 
any color. When Resaturation is less than 10% (and Bleed is less), a brush stroke fades in gently. When the Resaturation slider is 
set at zero and Bleed is set high, an airbrush can move underlying colors, as when just the airbrush hose is used to blow paint 
around on the canvas.  
 
Bleed 
The Bleed slider controls how much the brush colors smear underlying colors, including the paper color. When Bleed is higher 
than resaturation, more color bleeds than covers, so the stroke never reaches full Opacity. 
 
Jitter 
The Jitter control introduces a randomized jitter to the brush stroke. Instead of appearing directly along the stroke, dabs appear 
randomly outside the brush stroke path. 
 
FILL IN THE BACKGROUND: 
Background is now filled in, using a large brush size and low opacity.  As you can see the edges of the flowers and the stems are 
covered over or blurred, but fear not, they are recoverable! 

 

But how do we recover those lost edges if we cannot see them?? 
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TRACING PAPER – what is it and how to use it. 

Using Tracing Paper  
Tracing Paper, is the on-screen “light box” in Corel Painter. To use Tracing Paper, the source and clone documents must be the 
same size. When Tracing Paper is in use, you see a faded-out version of the clone source, as if it were displayed under real tracing 
paper on top of a light box.  
 
As you trace, brush strokes appear at 50% opacity that you selected. When you finish tracing and turn Tracing Paper off, the faint 
source image disappears, and your brush strokes appear at 100% of the opacity you selected. You can toggle back and forth to 
monitor how the painting looks as you progress and you should find this to be an indispensable tool. 
 

 
 
ADDING DETAIL TO THE PAINTING – Once the background is done, you can begin to add detail to the main subject by 
reducing brush size and increasing opacity as you work.  You probably find that you will need to work an area to get the look you 
want and by doing so, you are laying down colors or building layers on the canvas as if you were really painting.  Adding layers 
gives depth to the painting – making the background recede and the foreground prominent.  Smaller brush sizes are absolutely 
critical to maintain fine detail, such as when painting the eyes and mouth of a person.  We will also add “texture” to the painting 
when it is finally done to enhance the 3d – depth effect.  
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Adding Texture 
This is the final step in finishing your painted masterpiece.   
 
Using Image Luminance to Create Texture  
When you create a texture using the Image Luminance method, the current image’s luminance, or lightness, determines where 
surface texture is added. Light parts of the image create dents; darker parts create raised areas. The overall effect gives an 
embossed look to the edges of the image.  
To create surface texture by using Image Luminance  
1   Select a layer or area of the canvas.  

 If you want to apply the effect to the entire image, do not make a selection.  
2   Choose Effects menu > Surface Control > Apply Surface Texture.  
3   In the Apply Surface Texture dialog box, choose Image Luminance from the Using pop-up 

menu.  
 If you want to apply an inverted texture, enable the Inverted check box. 

4  Adjust the Softness slider to control the amount of distortion created by the texture .  
 Increasing softness creates more intermediate steps, which produces a smoother distortion. 
5   Adjust the Appearance of Depth sliders.  
 Refer to "Setting Appearance of Depth Properties" for more information.
6   Adjust the Light Controls sliders.  
 For more information, refer to "Applying Lighting to a Texture".
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With texture: 

 
 
Finished painting: 
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APPENDIX  
 
BRUSH CATEGORIES/BRUSHES 

Corel® Painter™ IX Brushes Guide  
 

Brushes are the heart and soul of Corel Painter IX—and they are one of the key elements that distinguish Corel Painter from other digital 
painter and illustration software.  

 
Corel Painter brushes consist of a wide range of preset painting and drawing tools called brush variants. Brush variants are organized into 
categories, such as Airbrushes, Artists' Oils, Calligraphy, Pencils and Watercolor. They are designed with real media in mind, so you can 

select a tool with an expectation of how it will behave. For example, you'll find a 2B Pencil brush variant in the Pencils category and a Fine 
Camel brush variant in the Watercolor category. The Brush Selector bar lets you choose a category and brush variant quickly and easily.  

 
 

You can use the Corel Painter brush variants as they are or you can adjust them to suit individual purposes. Many artists use Corel Painter 
brush variants with only minor adjustments to size, opacity, or grain (how much color penetrates paper texture). You can make extensive 

on-the-fly modifications to a brush by dragging sliders in the Brush Controls. It's also possible to create entirely new brushes, or new 
variants of existing brushes, using the Brush Creator. Brushes, including libraries from previous versions of Painter, can be saved and 

loaded as desired.  
 

Take a look at the brush categories, as well as highlights of some brush variants, you'll find in Corel Painter IX.  
 

Acrylics 
 

All Acrylic brush variants cover underlying brush strokes. Many are capable of multicolored strokes, and others interact with underlying 
pixels to create realistic effects.  

   

Captured Bristle Thick Acrylic Flat Wet Acrylic 

 

Airbrushes 
 

Airbrushes apply fine sprays of color. Computed airbrushes carefully mirror the feel of a real airbrush in action. The Wacom? airbrush 
stylus is fully compatible with the airbrush variants.  

   

Coarse Spray Fine Spray Digital Airbrush 

 

Artists' Oils 
 

Brush variants from the Artists' Oils category let you mix paints as though you were working with traditional oil paints. You can use colors 
mixed on the Mixer palette and apply them directly to the canvas. The colors can then be blended with the oils already on the canvas. 

Multiple colors from the Mixer palette can be loaded on an Artists' Oils brush variant at the same time. Each stroke created with an Artists' 
Oils brush variant loads the brush with a finite amount of oil, which is then transferred to the image. As you apply a stroke to the canvas, 
the Artists' Oils brush loses oil, and the brush stroke becomes fainter. Because layers don't have the oily properties of the canvas, brush 
strokes applied to a layer don't fade as rapidly. Some Artists' Oils brush variants are palette knives, which allow you to mix paint directly 

on the canvas.  
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Bristle Brush Soft Grainy Brush Thick Wet Impasto 

 
 

Artists 
 

Artists brush variants help you paint in the styles of master artists. For example, you can paint in the style of Vincent Van Gogh, where 
brush strokes are multishaded, or in the style of Georges Seurat, where multiple dots combine to form an image. When you use any of 
the Artists brush variants, dragging quickly produces wider strokes. You can use the Color Variability settings to adjust how the Artists 

brush strokes are colored.  

   

Impressionist Sargent Brush Seurat 

 
 

Blenders 
 

Blenders affect underlying pixels by moving and mixing them. The variants can reproduce the effects of blending paint by applying water 
or oil. You can also smooth drawing lines and create shading just as you would on a pencil sketch or charcoal drawing.  

   

Just Add Water Smear Smudge 

 
 

Calligraphy 
 

Whether you want to reproduce the look of calligraphy pen strokes on a grainy texture or the smooth strokes of a calligraphy brush, the 
Calligraphy brush variants offer you a range of creative options.  

   

Calligraphy Calligraphy Brush Dry Ink 

 
 

Chalk 
 

Chalk brush variants produce the thick, rich texture of natural chalk sticks and cover with strokes that interact with the paper grain. Their 
opacity is linked to stylus pressure.  

   

Blunt Chalk Square Chalk Variable Chalk 

 
 

Charcoal 
 

Charcoal brush variants range from pencils to hard or soft charcoal sticks. As with other dry media brush variants, their opacity is linked 
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to stylus pressure. You can use Blender brush variants to soften and blend the charcoal strokes. For a smooth workflow, keep your 
favorite Charcoal and Blender brush variants together in a custom palette.  

   

Charcoal Hard Charcoal Pencil Soft Vine Charcoal 

 
 

Cloners 
 

Cloner brush variants behave like other brush variants, except that they take color from a clone source. These variants re-create the 
source imagery while effectively filtering it, reproducing the image in an artistic style, such as pastel chalk or watercolor.  

   

Original photo used as the 
Clone Source 

Camel Oil Cloner Chalk Cloner 

   

Furry Cloner Impressionist Cloner Soft Cloner 

 
 

Colored Pencils 
 

Colored Pencils interact with the canvas texture and, unlike other dry media brush variants, apply strokes with even opacity, regardless of 
pressure; however, these brush variants do react to speed. For example, dragging quickly produces a thinner line; dragging slowly 

produces a thicker line. As with all pencil-style brush variants, Colored Pencil brush variants build to black as you draw over the same 
area of the image.  

   

Colored Pencil Hard Colored Pencil Oily Colored Pencil 

 
 

Conté 
 

Similar to Chalk, Conté brush variants produce textured strokes that interact with the paper grain. As with other dry media brush 
variants, their opacity is linked to stylus pressure.  

   

Dull Conté Square Conté Tapered Conté 
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Crayons 
 

Crayons offer a range of styles. From soft and dull to waxy and grainy, they produce textured strokes that interact with the paper grain. 
As with other dry media brush variants, opacity is linked to stylus pressure.  

   

Basic Crayon Grainy Hard Crayon Waxy Crayon 

 
 

Digital Watercolor 
 

Digital Watercolor brush variants produce watercolor effects that react with the canvas texture. Unlike Watercolor brush variants, which 
work with the Watercolor Layer, Digital Watercolor strokes can be applied directly to any layer, including the canvas. For example, if 
you're applying watercolor effects to a photo image, Digital Watercolor brush strokes can be applied directly to the image. If you're 

creating a watercolor image from scratch, the Watercolor brush variants allow colors to flow, mix and absorb more realistically.  
Digital Watercolor brush strokes affect each other as you apply one brush stroke on another, and they react dynamically to the Wet Fringe 

setting. When you achieve the results you want, you can keep the brush strokes from changing by "drying" the image. The width of 
Digital Watercolor brush strokes is affected by stylus pressure, with the exception of the Wet Eraser brush variant.  

   

Broad Water Brush Diffuse Water Dry Brush 

   

Gentle Wet Eraser applied to a 
brush stroke 

Simple Water Salt applied to a brush stroke 

 
 

Distortion 
 

Distortion brush variants apply special effects that distort an image. Some variants, such as Grainy Distorto and Grainy Mover, produce 
blending effects. Other variants, such as Hurricane, Turbulence and Water Bubble, produce more dramatic effects.  

   

Bulge Confusion Hurricane 
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Erasers 
 

There are three types of Eraser brush variants: Eraser, Bleach and Darkener. Eraser brush variants erase down to the paper color. Bleach 
brush variants erase to white, gradually lightening by removing color. Darkener brush variants are the inverse of Bleach variants; they 
gradually increase color density, building colors toward black. With all Eraser brush variants, pressure determines how much you erase.  

   

Bleach Eraser Flat Eraser 

 
 

F/X 
 

F/X brush variants give you wildly creative results. Some add color; others affect underlying pixels. The best way to appreciate F/X brush 
variants is to experiment with them on an image and a blank canvas.  

   

Fairy Dust The Fire brush works with 
underlying colors 

Glow 

 
 

Felt Pens 
 

Felt Pen variants let you create marker-style drawings. The brush variants range from fine point to blunt, and they have a variety of nib 
shapes and opacity levels. Felt Pen brush variants build to black as you draw over the same area of the image.  

   

Art Marker Dirty Marker Felt Marker 

 
 

Gouache 
 

Gouache brush variants let you paint with the fluidity of watercolors and the opacity of acrylics. These variants range from fine, detail 
brushes to flat or thick brushes. Brush strokes created with Gouache brush variants cover underlying brush strokes.  

   

Detail Opaque Thick Gouache Flat Wet Gouache Round 
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Image Hose 
 

The Image Hose is a special brush that applies images instead of color. The images it "paints" with come from special image files called 
nozzles. Each nozzle file contains multiple images that are organized by characteristics such as size, color and angle. Each characteristic 

(parameter) can be linked to a stylus attribute (animator), such as Velocity, Pressure and Direction.  

   

Linear-Angle-B (Bearing) Linear-Size-P (Pressure) Spray-Size-P (Pressure) 
controls size and spread 

 
 

Impasto 
 

Impasto brush variants let you re-create the classic technique of applying thick paint on a canvas to provide depth to your image. The 
depth information for the brush stroke is stored on the Impasto Layer. Some variants apply depth effects to underlying pixels, such as 

Acid Etch, Clear Varnish, Depth Rake and Texturizer Clear. Other variants apply 3D brush strokes with the current paint color.  

   

Opaque Flat Smeary Round Loaded Palette Knife 

 
 

Liquid Ink 
 

Liquid Ink brush variants combine ink and paint to create a thick, liquid paint effect. There are three main types of Liquid Ink brush 
variants: ones that apply ink, ones that remove ink to create a resist effect, and ones that soften edges. Like Watercolor brush variants, a 
new layer is created automatically when you first apply a brush stroke. You can also create 3D effects by double-clicking a Liquid Ink layer 

and adjusting the Threshold and Amount sliders.  

   

Clumpy Ink Coarse Bristle Graphic Bristle 

   

Smooth Flat Sparse Camel Tapered Thick Bristle 
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Oil Pastels 
 

Oil Pastel brush variants produce the thick, rich texture of natural pastel sticks. Most Oil Pastel brush variants cover existing brush strokes 
with the current paint color; however, the Variable Oil Pastel brush variants blend the underlying color into the brush stroke. As with other 

dry media brush variants, opacity is linked to stylus pressure.  

   

Oil Pastel Chunky Oil Pastel Variable Oil Pastel 

 
 

Oils 
 

Oil brush variants let you create effects you'd expect from oil paints. Some variants are semitransparent and can be used to produce a 
glazed effect. Other variants are opaque and cover underlying brush strokes. For realistic interaction with the Mixer palette, and to apply 

multiple colors in a single brush stroke, try using Artists' Oils brush variants.  

   

Fine Camel Opaque Flat Smeary Round 

 
 

Palette Knives 
 

You can use Palette Knife brush variants to scrape, push or pick up and drag colors in your image. Only one Palette Knife brush variant, 
the Loaded Palette Knife, applies the current paint color. Palette Knife dabs are always parallel to the shaft of the stylus.  

   

Loaded Palette Knife Palette Knife applied to a brush 
stroke 

Smeary Palette Knife 

 
 

Pastels 
 

Pastels range from hard pastel styles that reveal the paper grain to extra-soft pastels that glide on to completely cover existing brush 
strokes. Their opacity is linked to stylus pressure.  

   

Artist Pastel Chalk Soft Pastel Square Soft Pastel 
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Pattern Pens 
 

Pattern Pen brush variants let you use a brush to apply a pattern to an image. You can vary features such as the size of the pattern and 
the transparency. For example, Pattern Pen Micro decreases the size of the pattern, and Pattern Pen Transparent applies a 

semitransparent version of the pattern.  

   

Pattern Pen Pattern Pen Masked Pattern Pen Marker is based on 
the current color 

 
 
 

Pencils 
 

Pencil brush variants are great for any artwork that would traditionally require pencils, from rough sketches to fine line drawings. Like 
their natural counterparts, Pencil brush variants interact with canvas texture. All of the variants build to black and link opacity to stylus 

pressure. The width of Pencil strokes varies according to the speed of the stroke, so dragging quickly produces a thinner line and dragging 
slowly leaves a thicker line.  

   

2B Pencil Cover Pencil Greasy Pencil 

 
 

Pens 
 

Pen brush variants, like the Scratchboard Rake and Bamboo Pen, create realistic effects without the drawbacks of natural media pens, 
which can clog, spatter or run dry.  

   

Croquil Pen Scratchboard Tool Thick and Thin Pen 

 
 

Photo 
 

Photo brush variants let you modify digital images or existing artwork. For example, you can clean up photos by adjusting color or 
removing scratches, add a blur effect or sharpen an image.  

   

Blur Dodge Burn 
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Sponges 
 

Sponges let you create a variety of textures by applying the current paint color to cover or blend existing colors. Some Sponge brush 
variants apply dabs of paint at random angles with each click of a stylus. Wet sponge brush variants, such as Grainy Wet Sponge, apply 

sponge dabs as you drag across the canvas. Smeary Wet Sponge variants let you blend the current paint color with existing colors as you 
drag across the canvas.  

   

Dense Sponge Grainy Wet Sponge Smeary Wet Sponge 

 
 
 

Sumi-e 
 

Sumi-e brush variants let you create flowing Sumi-e?style brush strokes. Choose from a variety of brush sizes and shapes to re-create 
traditional Sumi-e brush strokes.  

   

Coarse Bristle Sumi-e Detail Sumi-e Sumi-e Brush 

 
 

Tinting 
 

Tinting brush variants let you apply effects to photos or existing artwork. For example, you can apply translucent color to areas of a black-
and-white photo using the Basic Round brush variant. By applying each color to a separate Gel or Colorize layer, you can adjust the 

opacity of each color layer independently for a more subtle or dramatic effect.  

   

Basic Round Blender Soft Grainy Round 

 
 

Watercolor 
 

Watercolor brush variants paint onto a watercolor layer, which enables the colors to flow, mix and absorb into the paper. The watercolor 
layer is created automatically when you first apply a brush stroke with a Watercolor brush variant. The layer lets you control the wetness 

and evaporation rate of the paper to effectively simulate the natural media. All Watercolor brush variants, except Wet Eraser, interact with 
the canvas texture. You can use Watercolor brush variants to apply a watercolor effect to a photo by lifting the canvas to the watercolor 

layer. To paint directly on the canvas, use a Digital Watercolor brush variant.  

   

Diffuse Flat Splatter Water Wet Camel 

 

 


